Verification TOC Control Software Manual
Verification report for comparison
Ganaral information
Crpanlzation: Shimadzu
User; Tanaka
Fiename: DACOMMON\TOSCNTRASOFT_VALWAL_TEST.TCC
z . Es Inafrument Conditions
Data Fles {=.pkt]
¢ Instrument Attachments: TOC 5000A + ASE 50600
' = = : £ TC-Cat Type: Norma! 3anse TC catalyst
Attach the peak profile data Bubble Removal: OFF
v Syringe Size: 250 pl
. . . . . injection Speed: s5TD
4. Select View/Calibration Curve to open the Calibration Syringe Wash: oN
Curve dialog box. This automatically opens Cattation Cunas ¢
val test.cal.
. . B . Filename: val_test.cal
5. Choose “Point to point without zero shift” as the Tite: 0-10ppm
Calculation Method. Select OK. Anelysla No. of Washes Unit Rangs Spargetime nl.vol Max 8D Mex &V
6. When prompted, save the calibration curve. = - = - - - = —
Spmgie Name Sample ID Cone. et M““t:?‘e’ ¥san Aren S0 oV
Slope; 32801
Intercapt; 2049.7
e = A"z 0.00008
Save the calibration curve
Callbration curve
34851 T T T LE——
7. From the Edit menu, select Recalculate. This /__,//"”
recalculates the data based on the new calibration 2 ., T
. f < : =
curve calculation parameter. In this way, the I P :
calculation function of the software can be evaluated. e[,/fj” o I . ;
8. From the File menu, choose Page Setup, and select the 000 o o .00
Default button for every tab.
9. From the File menu, select print. Confirm the printer
setup and select OK.
When the report has printed, compare 1_1: to the printout ST : T
given here. The reports should be identical, except for the Page 1/2
General Information. Identical reports verify that the . o
software is operating properly and has not been corrupted. o Verification Report — Page 1
If the reports are not the same, ensure that the procedure '
was followed correctly, and that the Page Setup settings
are correct. Contact your Shimadzu representative for
further assistance.
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Appendix A

Error Message Severlty Levels

For information only

Error Meé_s_-ag_e_s

The requested action cannot be complete‘d but: the

user can continue to use the software

System Failure: exit the apphcatmn and .estart;f':"'

Instrument Error: instrument malntenance 1s"'requ1red'

Fatal Instrument Error: contact your Shlmadzu

representative

Error Messages

Samplas
Sample Name: sample
Sample il 1
Mathod: val_test.met
Cal Curve: 1: val_testeal
Type Anslynls Sparge Tima CratefTime
Unknewn (1C B 19971107 18:57:54)
Meen Area Cong Hesull Na, Of Washes $D GV
18841 5.0%88 ppm 4 604788 5,959%|
No. | Renge Inl.Vel. Aren Cant Exel, Data/Time: Cal Curve
1 1 53 18478] 5.009) 1207/11/0T 18:51:00 val_tesl.cal
2 1 53 17974 4.855! B3 SINI07 185318 val_tabtew
] 1 83 18781 5.104 1907/1 407 18:66:30 val_test.cal
4 1 53] 18884/ 3.082] 1207H Q7 18I wal_tisl.cal
Paak Profile
1 T T T
£ o :
g e {\ 5 r\ :
& \ ! :
“’ / S : ;
: i
AN AN A .
_1 t 3 J
0 5 10 18 20
Time fmin]
Stafisties [ Summary
Samphe Name Analysio £ong. Aeruit
agmpie TC 8,088 ppm
Srimadzy, Tanaka 199711 2/16 09:06:18
s
Paga2/2

Verification Report — Page 2

Message Severity Reason Action

Acid addition volume is 2 Wrong Parameter Check the Method conditions according to

not valid the current instrument settings

Argument Error 4 Communication Check the parameters for the current action

AST not initialized 5 Instrument Execute [Options][Maintenance][Initialize
AST]

Calibration curve not 2 File System Check the path

found _

Cannot create 2 PC Check the path

; 1

directory! Check the hard drive for free space

Cannot delete file 2 File System Check the path and file name

Cannot open COM 3 Communication Check the communication parameters
Check the RS232 cable for correct
installation
Check the DIP switches on the instrument
RS232 board

Cannot open method 4 Methods Check the path and file name

file

COM already opened 3 Communication Use another COM port

196

197



Error Messages

Message Severity Reason Action
Command not sent 5 Communication Retry this function later
Control data Listisnot 1 File system Does the file CCHART.DAT exist in the
valid, function cannot applications program directory?
be executed.
CV is not vahd 2 Wrong Parameter Check the Method conditions according to
the current instrument settings
Dilution factor is not 2 Wrong Parameter Check the Method conditions according to
valid the current instrument settings
Error in receiving data 3 Communication Check the communication parameter
Check the RS232 cable for correct
instalation
Check the DIP switches on the instrument
RS232 board
Error in sample table 2 Wrong Parameter Check the Method conditions according to
line: the current instrument settings
ERROR!! Arm 5 Instrument Shut down the instrument
hor?z'o ntal home error Perform ASI maintenarnce
position
ERROR! Arm 5 Instrument Shut down the instrument
horizontal pulse count error Perform ASI maintenance
ERROR! Arm lower 5 Instrument Shut down the instrument
. limit error Perform ASI maintenance
ERROR!N Arm vertical & Instrument Shut down the instrument
home position error Perform ASI maintenance
ERROR! Arm vertical 5 Instrument Shut down the instrument
pause position error Perform ASI maintenance
ERROR! Arm vertical 5 Instrument Shut down the instrument
pulse count error Perform ASI maintenance
ERROR!! Cannotfind 5 Instrument Check the instrument
syringe zero pomnt error Process “Zero Point Detection”
ERROR! Illegal power b5 Instrument Check the instrument
off error

198

Message

Severity

ERROR!! Position 6
detection for syringe
pump four-port valve
abnormal
ERRORI' RAM /ROM 6 Instrument
error error
ERROR! SSM IC 3 Instrument
furnace not ready error
ERROR!! SSM sample 5 Instrumenf
boat position error .
O the Instr
PerformSSM maintenanc
ERROR!‘! SSM sample 5 Instrument Try to move the sample rod
boat position detector error e
Check the SSM sample
correct position:
ERROR!! SSM TC 3 Instrument Is the SSM connected
furnace not ready error e
Check the settings of the temperature: -
controllor S CODETaEe
ERROR! Syringe 6 Instrument Shut down the instruﬁ:ent.:.
pump error error '
ERROR! Syringe' 3 Communication Perform zero point detection oi‘ chaﬁge t}:u.a. -
pump home position syringe
not detected
ERROR! TC furnace 6 Instrument Shut down the instrument
overheat error
ERROR! 6 Instrument Shut down the instrument
Thermocouple error
disconnected
ERRORN 6 Instrument Shut down the instrument
Thermocouple shorted error
ERROR! Turntable 5 Instrument Shut down the instrument
detector error
Perform ASI maintenance
ERROR! Turntable 5 Instrument Shut down the instrument
home position error

Perform AST maintenance
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Error Messages

Communication error

Message Severity Reason Action
ERRORI! Turntable 5 Instrument - Shut down the instrument
pulse count error Perform ASI maintenance
Error: COM not ready 4 Communication Check the communication settings of the
software _
Check the DIP switches on the instrument
communication board
Check the RS232 cable for correct
connection to the PC '
| Error: Communication 4 Commumnication Check the communication settings of the
port not opened software _ :
Check the DIP switches on the instrumen
communication board
Check the RS232 cable for correct
connection to the PC
Error: Get EOT 4 Communication Check the communication settings of the
software
Check the DIP switches on the instrument
communication board
Check the RS232 cable for correct
connection to the PC
Error: Parity error 4 Communication Check the DIP switches on the instrument
communication board
Check the RS232 cable for correct
connection to the PC
Check the communication settings of the
software
Error: Time Out 4 Communiecation Check the DIP switches on the instrument
communication board
Check the RS232 cable for correct
connection to the PC
Check the communication settings of the
software
Error: Unknown 4 Communication Check the communication settings of the

software
Check the DIP switches on the instrument
communication board

Check the R8232 cable for correct
connection to the PC
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Message Severity Reason Action

File cannot be opened! 4 File system Does the file CONTROL.DAT exist in the

The application creates applications program directory?

anew empty control Check the file path.

data list.

File not found! The 1 File system Does the file CCHART.DAT exist in the

application creates a applications program directory?

new empty control data Check the file path.

list,

Filenames must be 1 File system Select another file name

different!

Hardware error 5 Communication Check the communication parameter
Check the RS232 cable for correct
installation
Check the DIP switches on the instrument
RS232 board

Tllegal Command 2 Communication The instrument is not in the correct status
to accept this action.

Check the function parameter
Check the instrument status
Execute the “ESCAPE® command
Retry this function later

Tllegal Mode 1 Communication The instrument is not in the correct status
to accept this action.

Check the instrument status
Execute the “ESCAPE” command
Retry this function later
Illegal Parameter 2 Communication The instrument is not in the correct status
to accept this action.
Check the function parameter
Check the instrument status
Execute the “ESCAPE® command
Retry this function later
Injection volume 2 Wrong Parameter Check the Method conditions according to

exceeds the upper limit

the current instrument settings
Check the syringe size

Injection volume is not 2

valid

Wrong Parameter

Check the Method conditions according to
the current instrument settings

- Check the syringe size

Injection volume is foo
smail

2 Wrong Parameter

Check the Method conditions according to .
the current instrument settings
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Error Messages

Message Severity Reason Action
Check the syringe size
Instrument Busy 3 Communication Retry this function later
Instrument error 5 Instrument Check additional error messages
notification error
Instrument is not 2 Communication Check the RS232 settings of the software
connected. Cannot )
execute this function! Connect the instrument
Instrument not ready 2 Instrument Check the instrument conditions
Retry this function later
Max. No. of injectionis 2 Wrong Parameter Check the Method parameters according to
not valid the current instrument settings
Memory allocation 4 Internal Windows  Close other applications
' o . ;
error! Apphcatlon will error Restart the computer
be terminated!
Increase the RAM size
No of washes too high 2 Wrong Parameter Check the Method conditions according to
the current instrument settings
No. of injection not 2 Wrong Parameter Check the Method conditions according to
valid the current instrument settings
Neo. of washes is not 2 Wrong Parameter Check the Method conditions according to
valid the current instrument settings
Not Connected 2 Communication Connect the instrument
Restart time isnot OK 1 Instrument Check the instrument date and time
The restart time has to be greater than one
hour from the current instrument time
R5232 busy error 5 Communication Retry this function later
8D is not valid 2 Wrong Parameter Check the Method conditions according to

the current instrument settings

Sparge time is not valid

2 Wrong Parameter

Check the Method conditions according to
the current instrument settings

Sparge time is too long

[ R-]

Wrong Parameter

Check the Method conditions according to
the current instrument settings

The catalyst defined in
the calibration curve is

not suitable for the
current instrument
conditions!

-t

Calibration curve

Does the calibration curve match the
current instrument conditions?
Instrument conditions must be changed
before creating a curve

The type of the
calibration curve

Method

Does the calibration curve match the
current instrument conditions?

doesn't match with the Ensure that the analysis type is the same in
method! both the calibration curve and method
202
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Message Severity Reason Action
g‘iarf,eiiz? 01: I:;: :(l)n the 2 File system Is the file suitable for the TQC-Control
. LT
a 11 * * * *
e Ts camt be pplication. (*.toc, *.cal,*.met,* pkt)?
opened
Timeout error 3 Communication Retry this function later
Unknown error 3 Communieation Restart the application
Vial is not defined 2 Wrong Parameter Check the Method conditions according to
the current instrument settings
Select appropriate tray
Zero point of the 2 Instrument Ch i
: : eck th £ iti i
e ot ety Sy e instrument conditions (Syringe

detected, cannot
execute function!

Ex?cute the [Options]-[Maintenance]-[Zero
Point Detection]
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Appendix B

Automatic Calibration Curve
Selection

When more than one Calibration Curve has been selected
in the Method dialog box, the optimum Calibration Curve
is selected automatically according to the following
procedure.

1. Measurement is initially conducted using the first
calibration curve in the list (CAL#1).

When the sample is lower in concentration than
CAL#1:

2. If the sample concentration (SAMP) is lower than the
highest standard concentration of CAL#1, and higher
than the other calibration curve standards (CALother),
the first calibration curve is used.

CAL#1 > SAMP > CALother = CAL#1 used

3. If two calibration curves have been designated, the
sample concentration is lower than the highest standard
concentrations for both CAL#1 and CAL#2, and the
concentration of CAL#2 is lower than that of CAL#1, then
the second calibration curve is used.

CAL#1 > CAL#2 > SAMP = CAL#2 used
4. If three calibration curves have been designated, the
selection is essentially the same: the closest concentration

of standard Calibration Curve that is still higher than the
sample concentration will be used.

CAL#1 > CAL#2 > SAMP > CAL#3 =~ CAL#2 used
CAL#1 > CAL#2 > CAL#3 > SAMP =~ CAL #3 used

When the sample concentration is higher than Cal#1,
and Cal#2 or Cal #3 (CALother) are higher in
concentration than Cal#1:

5. If the sample concentration is marked with an “H”
(indicating that the peak height exceeded the full scale of
CAIL#1), the other calibration curve is used.

CALother > SAMP H > CAL#1 = CALother used
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Appendix B

Automatic Calibration Curve Selection

6. If SAMP 1s not marked with an H, the program
performs a ratio calculation. The ratio of the measured
sample concentration and CAL#1 is compared to the ratio
of the sample concentration and CALother. In most cases,
CAL#1 is selected, because the NDIR is linear for any
range setting, and a concentration within full scale range
will not be far greater than CAL #1. Therefore, using
CAL#1 will be at least as accurate as if another
calibration curve is used.

CALother > SAMP > CAL#1 = CAL#1 usually used

7. If SAMP is higher than that of both CAL#1 and
CALother, the other calibration curve is used.

SAMP > CALother > CAL#1 = CALother used

8. If SAMP is higher than CAL#1, and the other two
concentration curves have higher concentrations than
CAL#1, measurement will be calculated based on the
lower concentration calibration curve that is closest to the
sample concentration. Then, the evaluation described in
Steps 5, 6 and 7 is conducted.

CAL#2 > SAMP > CAL#3 > CAL#1 = CAL#3 usually used
SAMP > CAL#2 > CAL#3 > CAL#1 = CAL#2 usually used

The following points about automatic optimum calibration
curve selection should also be considered:

+ The procedures described above are valid for both
single and multi-point calibration curves.

+ For multiple injections, when the first peak is within
the full scale, while succeeding peaks exceed the scale,
operation will continue based on the first injection.
The amount that the successive peaks exceed the
range is considered too small to affect the
measurement,

4 The TC catalyst type (Normal or High sensitivity) and
the syringe size must be the same for the calibration
curves selected.

¢ Different units can be used for the calibration curve
concentrations, provided the units are of the same
grouping (i.e., a combination of ppm and ppb, or mg/L
and pg/L).

206
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¢ When analyzing samples with an expected wide range
of concentrations, set the concentration ratio between
two calibration curves to between 5 — 10. Since the
measurement always begins with CAL#1, this should
be the curve most likely to be used. The selection of
CAL#2 and CAL#3 depends upon their concentrations
and the expected sample concentrations.

4 Automatic selection of the optimum calibration curve
cannot be used in measurement based on the carbon
equivalent.
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Appendix B Automatic Calibration Curve Selection
Index
Tegeneratin
using high sg
H . Clear data, 655
Close, 51 .
ne C, 142 CNV, 142
. Coefficient of determinstis
A _ Coefficient of variatio
. _ Common status bar; 47
Analysis Configuration '
starting, 98 PC, 124
{(‘. s{:opl?ing, 100 saving, 125
viewing current, 79 Connect, 100
Append, 98 Continue, 100
Arrange icons, 130 T Control charts
ASCII, 127 SRR comparison, 181
AST exporting data, 188 :
analysis without, 98 : following, 176 o
choosing vials, 109 geneval parameters, 174, 184 .
configuring for, 109 - ' o opening, 96 '
connection, 122 R overview, 169
mechanical check, 118 SRR statistics, 179
parameters, 109 R - Control tracking
Attach data file, 52 : : adding and editing, 95
‘ Auto generate, 66, 84 disabling, 96
Auto restart, 101 set-up, 94
Control-period, 175
B Controls, set-up, 23
: ) Copy, 64, 143
Background monitor, 81 . Cross-hair, 143
Baseline, 141 Curve fits, 73
Baseline fluctuation, 81 Cut, 64
i Q. Baseline profile graph, 81
o Blind value control, 169, 173 D
Buzzer, 105
Data
C : excluding, 65, 76, 141, 147
exporting, 127
Calculation method, 73 ' exporting contrel charts, 188
Calculations, 165 exporting validation, 163
Calibration (validation), 161 integrity, 191 :
Calibration curve recalculating, 71
: automatic selection, 205 Database, 129
‘ | 3 creating, 73 Datasheet, 159
s listing, 78 " Default parameters, 4
listing current, 77 Deleting files, 52
opening, 72 DIN 38402, 74, 165, 164
specifying, 87 Display
Cascade, 130 choosing a font, 62
Catalyst settings, 113
changing, 123
208




Index

E

Error messages, 197
Escape, 102
ESU, 106
Exclude, 65, 76, 141
Exclusion (control charts), 189
Exclusion limit, 176, 185
Export options, 128
Exporting
control chart data, 188
data, 127
vahdation data, 163

F

File extensions, 3

Fixed content standard, 173
Flow lines, cleaning, 117
Following CC, 176

Frames, 61

Furnace, 141

G

General information, 105

General parameters
control, 174
validation, 162

Graphs, customizing, 142

Gnid, 145

Grubbs test, 147

H

Halt, 100

Hardware requirements, 7
Height, 140

Homogeneity of variance, 160, 182

I1C, 6
IC solution, regenerating, 107, 116
Initialize ASI, 122
Injection remarks, 140
Injection table

description, 139

display, 114

opening, 78
Injections, 78
Insert control, 69, 84
Insert sample, 69, 84
Insert standard, 68
Installing, 8
Installing ODBC drivers, 15
Instrument

auto restart, 101

configuration, 105

connection, 100

date & time, 125

shutdown, 101
Instrument conditions, 105
Instrument control, 1
Instrument control bar, 48, 92
Instrument parameters, overwriting, 50
Instrument status, 125
Instrument status bar, 45

L

Limits, 144

Line colors, 145
Linear regression, 73
Linearity, 159

M

Maintenance, 115
Map network drives, 51
Margins, report, 61
Max CV, 113
Max SD, 113
Mean, 76
Mean value control, 169, 172 :
Measurement completed, 99
Measurement mode, 99
Measurement parameters, 112
Mechanical check, 117
Message log, 82
Method

creating, 83

opening, 83

Method parameters, based on calibration, 87

Method validation, 96
calculations, 165
calibration, 161
datasheet, 159
exporting, 163
general parameters, 162
homogeneity of variance, 160
linearity, 159
overview, 1565
residual apalysis, 160
Modified, 141
Monitering instrument status, 126

N

NDIR, 5, 81
Network, 51
New, 49
Notes, 140
NPOC, 5
NPwI, 6
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ODBC, 8, 15, 129

Open, 49

Operation, principles, 4
Options, 145

Qut of control events, 82, 182
Qutlier test, 147 .
Outliers, identifying, 149
Overwrite, 98

P

Parameters
default, 4
measurement, 112
Paste, 64
Pause, 100
PC configuration, 124
PC Control, 1
Peak profile, 82
Peak stop, 102
POC, 6
Point-to-point, 73
Precautions, 1
Pre-period, 175
Principles of operation, 4
Print, 54
Print preview, 54
Printer setup, 55
Prm file, 4
Program check, 191
Program window overview, 43

Q

Quick report, 103

R

2, T4
Radar, 146
Range and injection volume, auto, 74, 107
Ready state checking, 108
Realtime window, 79
Recalculate, 71
Recaleulation, validation, 164
Recovery control, 169, 172
Repiace, 65
Report
choosing a font, 62
defining margins, 61
previewing, 54 .
printing, 54
printing a footer, 61
printing a header, 61
quick, 103
run time, 163

Requirements, hardware, 7
Residual analysis, 160

Residue removal, 116

Revision 23, 70, 71, 86, 97

Rinsing flow lines, 117

RS232 parameters, 111

Run time report, 103

Run time report configuration, 104

S

Sample table
command, 82
description, 133
display, 114
£ill out automatically, 66
inserting a control, 69
inserting a sample, 69
inserting a standard, 68
Sample volume count, 116
Save, 51
Save As, 51
Save configuration, 125
Select all, 64
Serial number, 14
Set instrument date/time, 125
Setup control samples, 93
Setup control tracking, 94
Shutdown instrument, 101
Selution, 141
Spanwidth contrel, 169, 174
Sparge gas flow, 107
Sparge time, 113
SQL, 129
58M
configuring for, 110
mechanical check, 120
parameters, 111
Stand-alone operation, 2
Standard deviation, 76
Standard, certified, 173
Standby, 100
Start, 98
Start measurement, 98
Start new RTR page, 103
Statistics table
description, 149
display, 115
opening, 89
Status bar
common, 47
instrument, 45
Stop, 100
Syringe, changing, 123
System suitability test, 97
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86, 97
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TOC, 5

W

Washing,

TOC-Link, 4

Toolbar, 43, 91
T-Test, 181

117

Tutorial, 21

U
Upgrading, 7

Zero point detection, 115

Zero shift, 73
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TOKYQ OFFICE
3. Kanda-Nishikicho 1-chome, Chiyoda-ku, Tokyo 101, Japan
Phona: {03)219-5641  FAX:(03)219-5710
Cable Add.iSHIMARZU TOKYQ

SHIMADZU CORDPDORATION Ovarsezs Tolos No.10232-3231 (SHMDT 3)
KYOTO GFFICE
1, Mishinokyo=Kuwabsrache, Nakagye-ku, Kyolo
604, Japan.
Cable Add.:SHIMADZU KYOTO
Overseas Tolex No..(05422-166 (SHMDS J)




